This is a concise summary of some of GibbsCam’s most fundamental features – they are the ones most often used in the PRL. It is intended to be a quick reference rather than a fully detailed manual or a comprehensive tutorial. Some prior introduction to GibbsCam is assumed.

The following topics are covered in this document

1. Geometry and Solids
2. Stock and Fixtures
3. Coordinate Systems
4. Contouring and Roughing
5. Cutting Threads
6. Surfacing
7. Miscellaneous Tips and Tricks

Geometry and Solids

Several GibbsCam functions, e.g. the Contour and Hole functions, work on geometry instead of the actual solid parts. Geometry in this case refers to points, lines, arcs, splines and related entities, and shares some similarities with sketches in SolidWorks. More complex geometry may lie outside of a single plane; in this case it becomes akin to a 3D sketch in SolidWorks. Geometry may be extracted from solids, or may be created from scratch.
Geometry from Solids

To extract geometry from a solid, we use the geometry extraction toolbar. In general, geometry is extracted from edges. Each tool allows you to specify a tolerance, which can mean something different for each tool.

Geometry EXTRACTION

This tool converts any edge(s) into geometry. Click on the desired edges, holding down the Ctrl key if more than one edge is needed. Double-clicking on an edge will select the entire chain of edges, as interpreted by GibbsCam. If this is not the desired chain/loop, you must individually select each edge. Be sure that the edges connect. The order of selection matters.

Hole EXTRACTION

The Hole function in the machining palette must act on either a point, or a circle (in which case, the radius of the circle is ignored – only the center point is considered). Part edges, even circular ones, are not seen as circles. The hole extraction tool is a good way to find the holes in a solid, and create the necessary circles for use with the Hole function. You may select the edge of a hole to extract the single hole, or the entire solid to find all holes.

The holes must be fully circular, i.e. the tool will not find an open-sided, semi-circular hole, and the walls of the hole must be perpendicular to the XY plane.

The hole extraction tool is the only way to extract holes on an undulating surface and have the resulting circles be at the right relative heights. These circles can then be used with the Hole function, with the Vary Depth with Geometry option on, to drill down to the right depth below the surface.
Outline

This is a quick way to get outlines or footprints of solids. Select either the entire solid, or specific faces. If unsuccessful, use the geometry extraction tool.

Geometry Creation

Use the geometry creation tools to create geometry. Many of these tools require coordinate points and/or existing geometry as inputs. For example, one way to create a point is to input its coordinates; another way is to derive it as the intersection of two lines.

Each tool has two buttons to execute the geometry creation with the given parameters:

1. One button creates the geometry, then takes you back to the main geometry creation menu.
2. The other button creates the geometry, but keeps the same tool open, allowing you to create more instances of the same type of geometry, but with different parameters.

Workgroups

All geometry, whether extracted or created, exists on a Workgroup. You can think of workgroups as layers that can be individually hidden or displayed, but that do not necessarily have a stack order.

Every new GibbsCam (.vnc) file comes with one default workgroup and it is possible to use the software without being aware of workgroups. However, you can create multiple workgroups to help manage your display if you have many overlapping geometries. Access the workgroup manager using the Workgroup button on the main toolbar.
Solids / Surfaces

In general most solids or surfaces in GibbsCam are imported from other solid modeling software packages. However, GibbsCam also has built-in Solid Modeling and Surface Modeling tools that allow you to create solids and surfaces from geometry. These tools are handy for creating simple shapes like cylinders and cuboids, but are non-parametric and so awkward to use for complex shapes.

Multiple Solids

GibbsCam allows you to work with multiple solids in the same file. Doing this allows you to

1. Import solids that represent stock material and/or fixtures, and designate them as such
2. Import multiple versions of the part to make certain operations more efficient. For instance, if your part has a surface interrupted by holes, performing a surfacing operation typically gives toolpaths that retract over holes. You might import a version without holes so that the surfacing operation is uninterrupted, which usually translates into less machining time.

You can manage these solids and un-clutter the main window using the Body Bag. Double-clicking on a solid sends it to the Body Bag, and double-clicking on the solid within the Body Bag sends it back out into the main window. Solids in the main window are not assigned to specific Workgroups; they are displayed in all Workgroups.
Stock and Fixtures

While machining, it is not uncommon to have fixtures extending through the part and/or above the surface of the part. To ensure that tools do not collide with the fixtures, it is useful to include fixtures and have GibbsCam take them into account during toolpath generation.

Also, GibbsCam allows stock sizes to be specified in the Documents dialog. However, this method allows you to specify rectangular prisms only. There are many instances where different stock shapes are used.

Stock and fixtures are discussed here in the same section because they are specified through a similar process:

1. Import or create the solids that correspond to the stock or fixtures. As mentioned previously, multiple solids can exist in the same .vnc file. If solids are imported from SolidWorks, for convenience, create fixtures and stock in the same SolidWorks part file as the actual part. This way, bodies only have to be imported once, and spatial relationships between the bodies are maintained.
2. Right click on the fixture or stock solid, and select Properties in the context menu that appears.
3. Select the button for Stock or Fixture as appropriate.
Fixture clearance can be set in the Documents dialog to tell GibbsCam how far to stay away from the fixtures. Fixture tolerance is the amount of deviation that can be tolerated from the specified clearance.

After creating your operations, pay careful attention to the Cut Part Render to make sure that tools do not run into fixtures. As an added precaution, set global and operation clearance planes at heights above the tallest fixture.
The stock designated in the Documents dialog is disregarded as long as there is at least one solid designated as Stock.

---

**Coordinate Systems**

All machining operations require a coordinate system. Part flips require multiple coordinate systems and careful thought about where to place them. Clearly, for part flips to work correctly as intended, coordinate systems set up in the machine must match those specified in GibbsCam. Either SolidWorks or GibbsCam can be used to designate multiple coordinate systems.

**Coordinate Systems in SolidWorks**

Perhaps the easiest way of creating multiple coordinate systems is to do so in SolidWorks. Every part file has one default coordinate system where the front plane corresponds to the XY plane. When importing the part file into GibbsCam, this coordinate system will always be used.

Oftentimes your design evolves so that you want to change the coordinate system of the part, or you wish to have multiple coordinate systems for part flips. You can create more coordinate systems but for GibbsCam to see these coordinate systems, the part must be saved as a parasolid.

These are the steps for creating more coordinate systems in your part and importing the part into GibbsCam with the desired coordinate system.

1. In SolidWorks, click on Insert > Reference Geometry, then make the appropriate selections in the sidebar to designate an origin and any two of the X, Y and Z axes. In some instances you may have to create a sketch beforehand marking out some features to align your origin and axes to.
2. Still in SolidWorks, click on File > Save As, choose the parasolid (.x_t extension) file type, then click on Options and select the desired coordinate system from the drop-down menu before saving the file.

3. Now in GibbsCam, click on File > Import, choose the parasolid file type, and open the desired file. The part should be imported with the desired coordinate system.

The only drawback with this method is that you will typically end up with having one .vnc file per part flip, and Cut Part Render cannot help you visualize the operations that have already been done on the other side of the material. To be able to do this, we must create the multiple coordinate systems in GibbsCam.

**Coordinate Systems in GibbsCam**

Translating the origin in GibbsCam is straightforward. Go to Modify > Move Part Origin, and enter the required values. Rotating the coordinate system is a little more involved. The orientation of the default coordinate system (named XY plane by default) cannot be changed. To rotate the coordinate system a new coordinate system must be created. You can create as many coordinate systems as you need.

![Coordinate Systems Button](image)

The new coordinate system starts out as a duplicate of the default, but we can change it using the coordinate system palette.
1. First specify the orientation. If the desired machining plane is parallel or orthogonal to the default, we can use the XY, YZ or ZX buttons to toggle through the possible orientations till we find the one we want. H and V refer to horizontal and vertical respectively. In the default coordinate system they correspond to the X and Y axes respectively. If, in the new configuration, any axis overlaps with the default, it retains the original labeling (X or Y). Use the Toggle Depth button to switch directions of the depth axis.

If the desired machining plane is not parallel or orthogonal to the default, then we need to use the align plane and axis buttons to align the new coordinate system to features that already exist in the workspace.

2. Next move the origin to the desired location. The easiest way to do this is to first create a point, then select the point and click on the Origin button.

The new coordinate system can now be specified and used in any of the process dialogs.
Choose the machining CS from the drop down menu.

Machining from both sides using multiple coordinate systems.
Contouring and Roughing

These two functions account for most of the machining processes generated by GibbsCam. They have many nuances associated with them, and familiarity with some of these subtleties will greatly enhance the chances that GibbsCam will perform predictably and as desired.

Contour

Overview

Think of the Contour function as an “outline” tool. Toolpaths generated by the contour function hug the perimeter of the selected geometry. In general, the Contour function will be paired with end mills or engraving tools (which can be specified as spot drills or end mills with custom settings) to create a process.

Selecting Geometry

The manual describes 3 ways to select geometry for use in conjunction with a Contouring process. Using these methods will yield predictable results. Other methods may not.

1. Extracted / Created Geometry

   This is the simplest case. The tool follows the same path at each Z step. You can choose to cut in the center, or on the left or right of the selected geometry. Geometry consists of lines, arcs, splines and combinations of the above. Closed contours are allowed. All geometry must be created using geometry creation tools (line, circle, etc) or, more commonly, extracted from the part; simply selecting part edges will not work.
• Part Gouge

The function acts on the selected geometry, and not the part. Although the geometry may originate from the part, the part is not considered during toolpath generation, i.e. GibbsCam has no qualms about gouging the part.

• Closed Loops

For GibbsCam to see a series of geometry as continuous, all constituents must be extracted at the same time, and they must form an uninterrupted chain. When selecting edges for geometry extraction, try double-clicking on a line segment. GibbsCam will attempt to find a continuous chain.

• Start / End markers

The black and white rectangles and circles allow increased control over the start and end points of the contours.

  o White is associated with the start point
  o Black is associated with the end point
  o Rectangles select the start/end feature. For a contour that is made up of different line segments, arcs, etc, the rectangles are each used to select one, and only one, of these segments.
  o Circles select the actual start/end point. They must lie on the feature selected by the respective rectangle.
The reason for this complexity is that GibbsCam will allow you to extrapolate certain features like lines and arcs – the circle (and hence the start/end point) can be placed not only along the feature selected by the rectangle, but also along any extrapolated point derived from the feature. See below for an example.

- **3D Contours**

  The contouring function can be used with 3D contours – i.e. paths that are not constrained to one horizontal plane.

2. **Solid Body**

   When GibbsCam is told to contour a solid body, the generated toolpath will trace the outline of the body at each Z step – i.e. the tool can follow a different path at each Z step if the part is not a straight extrusion. However, if there are undercuts, the tool should not gouge the part. If there are pockets in the part, the tool will outline these as well, but will not remove material from the interior of the pocket.
3. **Solid Body + Closed Contour**

This is similar to method 2. above, but the closed contour acts as a bounding box, and only the toolpaths lying within the box are retained. The closed contour should be made up of created or extracted geometry. To select multiple entities (body + contour), hold down the Ctrl key while clicking on the desired geometry. You may find that you need to double-click one of the segments of the closed contour to select the entire loop.
Use Stock

When Use Stock is selected, only toolpaths that intersect the designated stock material are retained. In some instances this saves time, but in other instances, the repeated interruptions can take even more time.
Rough

Overview

Roughing is a function for removing material from a larger area as compared to the contour function, where the tool follows a single line. In general, the Rough function is paired with a roughing end mill or finishing end mill to create a process. We will limit this discussion to the Offset option within the Rough process dialog. This option has the widest ranging applications and you may explore the other options on your own.

Selecting Geometry

The manual describes 4 ways to select geometry for use in conjunction with a Roughing process. Using these methods will yield predictable results. Other methods may not. The first 3 methods are analogous to the methods introduced in Contouring above.

1. Extracted / Created Geometry (Closed Contour)

This creates a pocket bounded by the contour selected. The geometry must be a closed contour. All geometry must be created using geometry creation tools (line, circle, etc) or, more commonly, extracted from the part; simply selecting part edges will not work.
• Part Gouge

The function acts on the selected geometry, and not the part. Although the geometry may originate from the part, the part is not considered during toolpath generation, i.e. GibbsCam has no qualms about gouging the part.

• Closed Contours

For GibbsCam to see a series of geometry as continuous, all constituents must be extracted at the same time, and they must form an uninterrupted chain. When selecting edges for geometry extraction, try double-clicking on a line segment. GibbsCam will attempt to find a continuous chain.
2. Solid Body

When GibbsCam is told to rough a solid body, the generated toolpath will, at each Z step, eliminate all material except the part. However, if there are undercuts, the tool should not gouge the part. This is quick to do in Gibbs, but the machining can be time consuming if lots of material needs to be removed.
3. Solid Body + Closed Contour

This is similar to method 2. above, but the closed contour acts as a bounding box, and only the toolpaths lying within the box are retained. The closed contour should be made up of created or extracted geometry. To select multiple entities (body + contour), hold down the Ctrl key while clicking on the desired geometry. You may find that you need to double-click one of the segments of the closed contour to select the entire loop.
4. Bottom Face of Pocket

The generated toolpath will rough out the pocket. This bottom face must not have a through hole in it or the process will not work.
Use Stock

When Use Stock is selected, the Roughing function removes all excess stock that does not intersect the desired part. As discussed in 2 above, this is not always practical. Deselecting Use Stock gives us yet more options for toolpath generation.

The following is only applicable when a solid body is selected for roughing (methods 2 and 3). When Use Stock is not selected, the designated stock material is not used. Instead, imagine the footprint of the selected body is extruded from the lowest Z height of the body to the highest Z height of the body. This hypothetical extrusion acts as the starting solid and the roughing process eliminates material from this starting point to get to the selected solid.
Useful Options Common to Both

Use Stock / Material Only

When material is selected, toolpaths cut only where material is left behind. Computer processing time for toolpath generation will go up, but machining time may be reduced. For Roughing, you may find that the toolpaths closest to the solid body may still be generated, even if the material there has been eliminated before.

Operation Clearance Plane

The tool will retract to this height in between passes (if Retract is selected) and at the start and end of the operation. Make sure this is set appropriately.

Hit Flats

GibbsCam allows you to enter a desired Z-step into the process dialog. If this Z-step does not exactly divide the total machining depth, GibbsCam will adjust the actual Z-step to give consistent depths of cut at each pass. The part may have flat areas that do not coincide with the Z-heights where machining takes place i.e. they may lie in between the passes. When Hit Flats is selected, GibbsCam introduces additional passes to make sure flats are machined where they should be.
Prefer Subs

If this is selected, GibbsCam will attempt to use subprograms in the resultant G-Code as much as possible. This will produce shorter code, but it might still be too long to store in the on-board computers. Subprograms cannot be used in conjunction with DNC (Direct Numerical Control) – i.e. dripping the program into the machine.

Cutter Comp / CRC On

G-Code is always generated with the relevant tool sizes selected in Gibbs. However, at run time, you may choose to deviate from these pre-selected sizes.

If this setting is off, you do not have this option. If you have to use a different tool size, you must make the changes in GibbsCam and reprocesses the G-Code.

If the setting is on, the G-Code includes the code for cutter compensation. Make sure the Tool Diameter Offsets on the machine console read 0 to make the cuts as programmed. A positive or negative offset is the deviation from the programmed tool size, and allows you to cut with a larger or smaller tool, respectively.

Ramp / Helix Entry

Even for a center-cutting end mill, plunging is significantly harder on the tool than is side-cutting. Ramp or helix entries reduce the vertical load on the tool when it is impossible to enter the material from the side, for instance, when cutting a pocket. Check the settings to make sure the ramp or helix begins above the part.

Stock / Island Stock / Pocket Stock / Z Stock

These allow extra stock material to be left behind for clean up later. Positive values leave extra material, negative values eat into the part.

When contouring in several passes, the transition between passes is often visible on the edge of the part. You can leave extra stock (on the order of 0.005”) and then do one final contour to clean up the entire edge with no extra stock.
During roughing, it is useful to leave extra stock all around (on the order of 0.005”) to ensure there is extra material for surfacing operations.

**Operation Specific Part / Constraint / Stock**

The machining palette allows the selection of parts (features to cut – we use this all the time), constraints (features to avoid) and stock that are **specific to the current operation only**. This means that you can designate stock or fixtures that apply to a certain operation but not to others.

**Cutting Threads**

The CNC machines can machine threads into parts. Advantages include speed, accuracy, perpendicularity, and repeatable start points.

**Tapping (Internal Threads)**

The appropriate tap drill should be used first to cut the minor diameter. For the actual tapping, we will use the Rigid Tapping option under Hole function. Rigid tapping means that tap is held rigidly in the spindle. The Z feed and spindle speed are matched in a ratio that determined according to the pitch of the threads. This is in contrast to tapping where the tool is mounted in a special holder that has compliance in the Z direction. The PRL does not possess this type of holder.

**Tool**

Ideally, spiral taps should be used in the CNC machines. They facilitate chip removal and reduce the risk of the tap binding and breaking due to chip accumulation. However, regular hand taps have been used successfully (and unsuccessfully). Know that there is a greater risk with hand taps and speeds should be turned down as an added precaution. Also, the tapping can be done in multiple passes, but this presents its own set of complications.

Securely hold the tool is a regular collet holder.
In GibbsCam, set the tool up as a rigid tap, and carefully specify the number of threads per inch. As far as tool set up is concerned, there is no difference between the rigid tap and tap designations, except that the Hole function will automatically select the appropriate option (rigid tapping vs. tapping) according to the tool.

**Process**

Use the Hole function in conjunction with the rigid tap and the center point(s) of the desired threaded holes. Spindle speed is calculated from the tap diameter and material, but it is recommended to turn this down as a precaution. GibbsCam will calculate the corresponding Z-feed. Specify the start and end Z-values as for any other hole.

In actual cutting, it will not be possible to feed hold during the tapping operation If Feed Hold is pressed, the machine will pause *after* the tapping. Use the emergency stop if necessary. Also, it is critical that the spindle speed and Z feed be matched. It appears (not completely verified) that the machine takes care of this by not accepting feed and speed overrides during this operation. To be doubly sure, reset the feed and speed to 100%.

**Thread Milling (External and Internal Threads)**

Thread milling is a method to produce external or internal threads using a spinning tool in a helical path. With the same tool, it is possible cut threads of different, arbitrary diameters and pitches, limited only by the dimensions of the tool. Also, the same tool can cut either left- or right-handed threads. These options make thread milling an attractive option for cutting large diameter threads where taps and dies are not available, or for making threads of non-standard specifications. Also, for a part that already needs complex machining, thread milling allows thread-cutting without an additional set-up on a lathe.

The appropriate major diameter (for external threads) or minor diameter (for internal threads) should be cut prior to the thread-milling operation.

**Tool**

There are various types of thread mills, but the ones in the PRL have multiple cutting flutes that lie in the same horizontal plane. While spinning, the tool appears to be a disk with a pointed edge.

The tool is held in a regular collet holder. In GibbsCam, use the Thread Mill designation and specify the dimensions carefully. Most of the dimensions should be given in the tool catalog.

**Process**

The process is created using the Thread Mill function and the thread mill tool. A center point (or a circle that shares the center point) is required to specify the center of the helix. The direction and diameter of the threads are specified in the process dialog (clockwise downwards for right-handed threads).
Use Clearance diameter to specify a larger diameter that the tool will cut in from on the first pass, for external threads.

If desired the threads can be cut in multiple passes, increasing/decreasing the diameter with each pass. The spiral will start at the same part of the circle each time, so no cross-threading should occur.
**Surfacing**

Surfacing is a powerful function commonly associated with full 3 axis machining. It is the tool used to generate toolpaths for cutting complex 3-dimensional surfaces. Flat areas can be surfaced too to produce a even finish.

In general, the surface should first be roughed out to get close to the desired shape, before using the surfacing tools to produce the final surface. Leave extra stock to remove during surfacing. Also, when using ball end mills, the tool will have to go below the Z-height of the surface at the edges. Therefore, you might consider cutting a surfacing relief outline around the part before beginning the surfacing operation to give some room for the tool to plunge.

GibbsCam will generate surfacing toolpaths for both finishing end mills and ball end mills. However, given the same size finishing and ball end mills, and the same XY step size, a ball end mill will usually produce a surface with a ridge height that is magnitudes smaller. Also, again with the same size finishing and ball end mills, the ball end mill is able to get into smaller spaces and hence can better reach hard-to-reach areas.

Also, large ball end mills will give smaller ridge heights than small ball end mills. If the part allows, using a larger tool allows fewer passes to get similar results.

When performing surfacing, select the desire faces to cut. You may select more than one surface, or even the entire body, in which case all surfaces are cut.

**Parameters**

Some of the parameters in the Surface process dialog have equivalents in the Contour and Rough process dialogs. Others do not. Here are some of the important ones.
**XY StepOver**

Surfacing toolpaths are usually parallel (or almost parallel) to each other. XY Stepover is the distance between each successive pass. In some respects, XY Stepover is similar to the cut width parameter in the Rough process dialog.

When XY Stepover is specified, XY StepOver is held fixed. Ridge Height varies. Machining marks are very consistent, and if the settings are fine enough, the ridges cannot be felt.

**Ridge Height**

Ridge height is the height of the inevitable scallops left behind in the part after a surfacing operation. In general, a ridge height of about 0.00001 is smooth to the touch. Any finer is probably unnecessary if sanding is to be done.

When Ridge Height is specified, Ridge Height is held fixed (approx). XY Stepover varies to achieve a consistent ridge height, so machining marks are less consistent. In theory this produces a smoother surface but in practice, once the resolution is fine enough, the difference in surface smoothness is indistinguishable.

For both of these settings, the finer the resolution, the smoother the surface, but the more time consuming the machining. Also, the resolution of the setting is limited by the Part Tolerance settings.

**Surface Stock / Z Stock**

Surface stock allows leaving extra stock normal to the surface for clean up later. Z stock leaves extra stock in the vertical direction. Positive values leave extra stock. Negative values eat into the part.

**Lace Cut**

Lace cut produces toolpaths that, when viewed from the top, appear as parallel straight lines. The direction of these lines can be specified. Viewed from the side, the toolpaths dip and rise to follow the undulations of the surface.
Lace Cut Toolpath at 0° Cut Angle
**Constant Z Rough, Z Surfaces Offset Rough**

Lace cut allows roughing out a solid by cutting the surface at Z intervals, specified in the Z Step. There are various algorithms for generating the toolpaths (in general, the toolpaths at each Z step are not the same). These options are seldom used since the Rough function generates more efficient toolpaths for roughing out material.

**One Finish Pass on Surfaces**

In contrast to roughing in intervals, One Finish Pass hits the surface in one pass. The Z Step input is grayed out when this is selected. This is the recommended setting. Of course, the surface should be rough cut beforehand.

Normal Vector Constraint allows you to specify the maximum normal angle of the surface, measured from the vertical. If Top Down to Normal Angle is selected, any area of the surface whose normal angle exceeds the maximum will not be cut. This is to prevent tool deflection at steep angles.

Ridge Clean Up cleans up ridges left behind due to tool deflection at steep normal angles. Cut direction must be specified appropriately (usually perpendicular to the original direction), and sometimes ridge clean up should be executed in multiple directions for best results.
Cut Over Edges

Select this option to cut slightly beyond the edges of the surface for a cleaner perimeter.

Skip Flats

All flat areas will be surfaced unless this option is chosen. In most cases, any time savings are minimal.
*Step Over Retract Options*

This option sets the condition under which a retract occurs in between each stepover – always, never, or when a given cut length to stepover width is encountered.

*Stay in Stock*

Cuts the surface only in the areas where there is stock material.

*Clear Stock*

Forces the toolpaths to go all the way to the edge of the stock, or just past it. Usually not useful.

*Surface Flow Cut*

With this method, generated toolpaths follow the curvature of the surface and the tool “flows” across the surface. Each surface is cut individually, even if they are selected all at once, so there will usually be a visible transition between surfaces.

Surface Flow Cut disregards the Max Z setting and will indiscriminately cut all selected surfaces, even if this means gouging the part. The Gouge Protect Option can help to a very limited degree, but can also prevent legitimate areas from being cut.

Common parameters include cutting along the long side vs short side, and cutting in one direction (theoretically better finish with climb cutting) vs back and forth (saves time).
2 Curve Flow

In 2 Curve Flow, two closed, non-intersecting contours are selected in addition to the surface to be machined. Instead of “flowing” over the surface, as in Surface Flow Cut, the tool “flows” along the contours selected. Machining only takes place in the area between the two contours. Since these contours can be created independently of the surface, 2 Curve Flow allows some level of control over the appearance of machine marks.
A point can be used as one of the contours. Also, in general, the two closed contours should have the same number of vertices.

2 Curve Flow Toolpath, cutting across curves. Selected curves are orange.
Analogous to Surface Flow Cut, you can choose to cut along the curves or across the curves, and one-way vs. back and forth. Cutting along the curves one-way allows a spiraling toolpath that is the only way to avoid seams in certain conditions. The order of contour selection determines whether the toolpath spirals in-to-out or out-to-in, and climb vs. conventional cutting determines whether the spiral curves clockwise or counter-clockwise.

## Miscellaneous Tips and Tricks

### Clearance Planes

There are two types of clearance planes in GibbsCam. Both must to set appropriately to avoid mishaps.

**Global Clearance Plane**

This is set in the Documents dialog. Tools go to this Z height just before and after tool changes.

**Operation Clearance Plane**

These are set in the individual process dialogs. Tools return to this level at the start and end of each operation, and also during any retracts during the operation.
Part Tolerances

Part tolerances determine how closely the machined part should approximate the solid model. Rough and finish tolerances are set in the Documents dialog and there is usually an option in individual process dialogs to choose between the two.

Making part tolerances smaller has the effect of producing toolpaths with more, shorter line segments. Part appearance will usually improve, cutting time may increase and processing time in GibbsCam will increase.

Sometimes the resolution of individual processes is limited by the part tolerances. For instance, if trying to do a Surfacing operation with a very small stepover, the part tolerance should be as small, or smaller, than the stepover.

Most processes allow you to override the part tolerance, so that a value other than the rough or finish tolerance can be used.

Post-Processor

Selected Ops

You can post-process selected operations (instead of all operations) using this option. Select the desired operations using the Ctrl and/or Shift key together with the mouse. Selected operations are yellow in the operations palette.

Minimize Line Numbers

This option removes line numbers from the output G-Code. Required sometimes when the line numbers get too large (on the order of 50,000, but no exact value at this time), which can cause errors on the HAAS machines.
Shortcuts for Selecting Multiple Features

Going to Edit > Select gives various options to select geometry. The Mouse Drag option is particularly useful.

Panning

Pan in GibbsCam by holding down Ctrl while dragging the mouse.

Shortcut for Getting Z-heights

Holding down the Alt key turns the cursor into a rectangle. Clicking on a surface while doing this copies the Z-height of the surface into the current input field.

Reusing the Same Process on a Different Selection

Suppose we have an existing operation, and we wish to use the same process parameters on a new selection, without having to set the parameters in the process dialog all over again. To do this:

1. Call up the process by double-clicking on the operation.
2. Update the selected contour, solid, etc.
3. If modifications to the process parameters are required, double-click the relevant process tile and edit the desired parameters.

4. Clicking Redo will overwrite the existing operation using the new selections. To retain the existing operation and add a new one, click on a blank operation tile, then click Do It.

**Multiple Operations Generated by the Same Process**

Oftentimes, a single process can generate multiple operations. This is particularly true for the Roughing function. When any one of these tiles is double-clicked, the entire group of operations becomes selected, and all the toolpaths are superimposed. At this point, click on a single operation tile within the group, then click within the main viewing area. The display shows the toolpath associated with the chosen operation.

The various operations in a group can be reordered or deleted as desired. However, if the original process is ever redone, all the operations will be reproduced in the original order.

**Blank Process and Operation Palettes**

If you think these palettes look blank, make sure there are no items above or below the currently visible area. Processes or operations that are hidden from view can lead to unexpected results and frustration.

**Operation Summary**

To bring up a summary of all operations, including depth of cut, spindle speed and feed rate, click on Window > Operation Summary. This window also gives an estimate of cut time, which is usually much shorter than the actual cut time for a variety of reasons including:

- The estimated cut time neglects rapid movements
- The cut time is calculated using the total cut surface and the feed speed. When line segments are very small (e.g. when approximating a spline with a very fine tolerance), significant time is taken up by the repeated acceleration and deceleration of the machine.
• The machines are often not run at 100% feed
• There is usually much stoppage time where parts are inspected in between operations